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Computer Wizard  - 1

Chapter – 1 : Computer: Its Parts

1. Tick (3) the correct answer :
a. speaker b. keyboard
c. printer d. CPU

2. Tick (3) the correct statements and cross (7) the wrong ones:

a. 3 b. 3

c. 7 d. 3

e. 7
3. Fill in the blanks :

a. keyboard b. mouse
c. monitor d. printer
e. tablet

4. Match the following :
a. 2 b. 1
c. 4 d. 3

5. Guess who am I?
a. COMPUTER b. KEYBOARD
c. CPU d. MONITOR
e. MOUSE

6. Answer the following questions :
a. A computer is an electronic machine.
b. The parts of a computer are-

UPS, Printer, Monitor, CPU, Mouse, Keyboard
c. Mouse helps in moving or selecting an item on the screen.
d. Speakers help in listening music and songs.
e. Different types of computer are-

Desktop, Laptop, Tablet
7. Unscramble the jumbled words:

a. COMPUTER b. MACHINE
c. LAPTOP d. KEYS
e. PRINTER

Chapter – 2 : Helping Parts of a Computer

1. Tick (3) the correct answer :

a. headphones b. compact disc

c. hard disk d. pen drive
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2. Tick (3) the correct statements and cross (7) the wrong ones:

a. 3 b. 3

c. 7 d. 7

3. Fill in the blanks :

a. printer b. keyboard

c. speakers d. Scanner

e. monitor

4. Who am I? One has been done for you :

b. SCANNER c. MOUSE

d. MICROPHONE

6. Answer the following questions :

a. The two helping parts of computer are- Printer and 
Scanner.

b. Uninterrupted Power Supply.

c. A printer helps us to print the work done in the computer 
on paper.

d. The headphones are used for listening to the music played 
on the computer in your ears only.

e. The combination of microphones and headphone is called 
as headset.

Chapter – 3 : Uses of Computer

1. Tick (3) the correct answer :

a. all of these

b. few seconds

c. booking tickets

2. Tick (3) the correct statements and cross (7) the wrong ones:

a. 3 b. 7

c. 3 d. 7

3. Fill in the blanks :

a. hospital b. music

c. text d. games

4. Arrange the jumbled words :

a. DRAW b. GAMES

c. PLAY d. SUMS
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5. Answer the following questions :

a. Two things which we can do on computer are- playgames 
draw & colour picture.

b. We have seen computer-

At your home At Shop

At school At Hospital

At office 

At Railway station and Airport 

c. The various uses of computer are :

(i) Play games  

(ii) Draw and colour picture 

(iii) Listen songs 

(iv) Write text

(v) Do sums 

(vi) View movie

Chapter – 4 : Working with Computer

1. Tick (✓) the correct answer :

a. main power supply b. monitor

c. desktop d. shut down

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✗ d. ✓

3. Fill in the blanks :

a. electricity b. UPS

c. shutdown d. CPU

4. Answer the following questions :

a. A first step to start a computer is Switch ON the main 
power supply.

b. The first step to shut down a computer is palace the 
mouse pointer at start button and press the left mouse 
button.

c. UPS supplies power to all parts of the computer.

d. The last step to shut down a computer turn OFF monitor, 
UPS and main power function.
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Chapter – 5 : Operating a Keyboard

1. Tick (✓) the correct answer :

a. Spacebar key b. Enter Key

c. Keys d. Two

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✓

c. ✗ d. ✓

3. Fill in the blanks :

a. keyboard b. enter

c. number d. alphabet

4. Arrange the jumbled words :

a. KEYBOARD b. NUMBER

c. ALPHABET d. SPACEBAR

e. ARROW

5. Answer the following questions :

a. The spacebar is used to insert blank space between two 
words or letters.

b. The Alphabet keys are used for typing words and 
sentences.

c. The arrow keys are used to move up, down, right and left. 
There are four in numbers.

d. Keyboard is used to work on a computer. It helps in 
typing.

Chapter – 6 : Operating a Mouse

1. Tick (✓) the correct answer :

a. Mouse b. pointer

c. single-click d. double click

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✓

c. ✗ d. ✓

3. Fill in the blanks :

a. pointer b. commands

c. click d. single

06



4. Answer the following questions :

a. Mouse is used to give commands to computer. Mouse is 
used to draw pictures & play games a computer.

b. Pressing a mouse button once is called single click.

c. Pressing a mouse button twice quickly is called double 
click.

d. The arrow on the computer screen is called the mouse 
pointer.

Chapter – 7 : Computer Do’s and Don’ts

1. Tick (✓) the correct answer :

a. hardly b. both (i) and (ii)

c. cover the computer d. all of these

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✗

c. ✗ d. ✓

3. Fill in the blanks :

a. shoes b. clean

c. dust cover d. wires 

4. Answer the following questions :

a. We should use dust cover to cover the computer, when 
they are not in use.

b. We should keep our hands clean and dry while working 
on computer.

c. (i) Keep the computer neat and clean.

     (ii) Always cover the computer with dust cover after using.

d. (i) We should not eat near the computer.

      (ii) We should not pull the wires of the computer.

Chapter – 8 : The Paint Program

1. Tick (✓) the correct answer :

a. Title bar b. ribbon

c. pencil tool

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✓

c. ✗
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3. Fill in the blanks :

a. pencil b. paint

c. eraser d. polygon

4. Answer the following questions :

a. Pencil tool and eraser tool

b. The Eraser tool is used to erase the unwanted portion of 
the drawing.

c. Fill with colour tool is used to fill colour in shapes.

d. Paint program is used to draw and paint picture.
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Computer Wizard  - 2

Chapter -1 : History of Computer

1. Tick (✓) the correct answer :

a. Abacus b. machine

c. CPU d. Pebbles

2. Fill in the blanks :

a. Napier’s Bones b. Pascal

c. Charles Babbage d. Difference engine

e. Memory

3. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✓

c. ✓ d. ✗

5. Answer the following questions :

a. Charles Babbage invented a new machine called 
Difference engine.

b. Input unit access the data / orders from the users.

c. Output unit shows the processed result.

d. CPU stands for Central Processing Unit. CPU acts as the 
brain of computer.

e. The main parts of computer are-

Input unit, Output unit, Processor, Memory unit

Chapter - 2 : Characteristics of Computer

1. Tick (✓) the correct answer :

a. TV b. all of these

c. calculator d. easier

e. computer

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✓

c. ✓ d. ✗

e. ✓

3. Fill in the blanks :

a. machine b. remember

c. fast d. electricity

e. device
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4. Fill in missing letters :

a. MACHINE b. COMPUTER

c. TIRED d. PHONE

e. DEVICE

6. Answer the following questions :

a. Computer is an electronic device which accepts our 
instructions and gives the output accordingly.

b. Computers are becoming so popular because-

• They are fast.

• They are accurate.

• They make our work easy.

• They can remember many things.

c. We can perform many different types of work on a 
computer like:

• Do calculation

• Play games

• Write text

• Make drawing

• Listen to music etc.

d. MAN is superior than machines because he created 
machines.

e. Yes, Machines are better than man as -

• Machines do not have brain to think. 

• Machines have no feelings.

f. Man has created machines -

• To overcome his weakness.

• To make his work easy.

• To finish his work fast.

• To do his work perfectly correct.

Chapter -3 : Computer: In Different Places

1. Tick (✓) the correct answer :

a. school b. operation

c. booking tickets d. keeping accounts

e. browsing internet
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2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✗ d. ✓

e. ✓

3. Fill in the blanks :

a. accuracy b. movies, cartoons

c. bills d. students

e. chatting

5. Answer the following questions :

a. Computer are used at various places. Some are as follows: 
In school, banks, Railway station, hospitals etc.

b. Records of money can be kept in computer. Record of 
customer is maintained on a computer.

c. Computers are used in school as things can be explained 
easily on a computer.

d. (i) In Railway Station- Railways tickets are printed on 
a computer.

Records of trains can be kept on a computer.

(ii) In Hospitals- Records of doctors and patients can 
be kept on a computer.

Medicines details are kept on computer.

(iii) In Shops – Total bill can be calculated and printed 
on a computer.

Chapter - 4 : Hardware And Software

1. Tick (✓) the correct answer :

a. Both (i) and (ii) b. printer

c. CPU d. keyboard

2. Fill in the blanks :

a. Hardware and Software b. Hardware

c. CPU d. Speakers

e. Software

3. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✓

c. ✓ d. ✗
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4.  What am I?

a. Keyboard

b. Floppy disk and Compact disk

c. Monitor

d. Speakers

5. Answer the following questions :

a. Hardware is the physical parts of a computer.

b. Software is a set of constructions used to operate 
computers and give correct output.

c. The activities done by the software :

(i) Storing the information in a floopy disk or in a 
compact disk (CD).

(ii) To open the space where the CD’s are placed on the 
computer.

d. Keyboard, Mouse.

6. Write the function of each :

a. Central Processing Unit – processes the data.

b. Mouse – helps to move the arrow and point towards the 
different items on the monitor.

c. Keyboard – helps to type the data.

d. Monitor – displays the data and the answers.

e. Printer – prints the output on the paper.

f. Speakers – are devices that help us in listening to sounds.

Chapter - 5 : Input and Output Devices

1. Tick (✓) the correct answer :

a. mouse b. printer

c. mouse d. keyboard

e. keys

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✗ d. ✓

e. ✓

3. Fill in the blanks :

a. typewriter b. printer
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c. mouse d. speaker

e. Joystick

4. Name the following :

a. Keys b. Monitor

c. Number keys d. Alphabet Key

e. Joystick f. Visual Display Unit

g. Printer h. Special keys

5. Answer the following questions :

a. Mouse helps us to point any object on the screen.

b. Monitor shows the work done by computer on screen.

c. Printer prints the work done by computer on a paper.

d. Input devices are any hardware device that sends data to a 
computer for processing.

Chapter - 6 : Operating a Keyboard

1. Tick (✓) the correct answer :

a. alphabet keys b. all of these

c. keys d. num lock key

e. caps lock key

2. Fill in the blanks :

a. data b. Num lock

c. cursor d. Arrow

e. Back space

3. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✓ d. ✓

e. ✗

5. Answer in one word only :

a. Alphabet keys b. Number keys

c. Caps lock d. Backspace 

e. Enter key f. Space bar

 g. Arrow keys h. Delete key

6. Answer the following questions :

a. Keyboard is an input device. It sends the data to a 
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computer by typing.

b. The main keys are : 

•   Alpahebet keys

•   Number keys

•   Special keys

c. Space bar key leaves a blank space when you are typing.

d. The small blinking line on the screen which shows your 
position on the screen is the cursor.

e. Numeric – Keypad is situated on a keyboard. It helps us 
to write numbers.

Chapter -7 : Operating a Mouse

1. Tick (✓) the correct answer :

a. monitor screen b. click

c. right click d. double click

e. none of these

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✗

c. ✗ d. ✓

e. ✓

3. Fill in the blanks :

a. input b. left-click

c. pointer d. left

e. mouse pad 

5. It helps to point an object 

It helps to write something on screen.

6. Answer in one/two words only :

a. Mouse Pad b. Click

c. Drag d. Double-click

e. Dust f. Input device

g. Pointer

6. Answer the following questions :

a. It shows our position on the screen. It helps you to draw 
pictures on the screen.

b. Mouse is an input device.
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c. Mouse has two or three buttons and one tail which link it 
to CPU.

d. Click, Double click, drag and point.

e. The position of mouse on the computer screen is called 
POINTER.

Chapter - 8 : MS Paint

1. Tick (✓) the correct answer :

a. rectangle b. airbrush

c. fill with colour d. text

e. eraser

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✓

c. ✗ d. ✗

e. ✗

3. Fill in the blanks :

a. drawing b. toolbar

c. Pencil d. Air brush

e. ellipse

5. Name the following :

a. Text tool b. Pencil tool

c. Eraser tool d. Ellipse tool

e. Background colour

6. Answer the following questions :

a. MS Paint is a very useful software to draw and colour the 
figures.

b. Mouse is frequently used in Paint.

c. The steps to start Paint are :-

•   STEP 1 click on Start button.

•   STEP 2 click on Program.

•   STEP 3 click on Accessories.

•   STEP 4 click on Paint.

d. Paint screen has following main parts:-

•   Title Bar •   Menu Bar

•   Tool Box •   Colour Box

•   Work Area
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e. (i) Text – This is used to write/ type something in 
Paint.

(ii) Air Brush – This tool gives the spray colour look 
on the screen.

(iii) Ellipse Tool – This tool is used to draw circles etc. 
of different sizes.

(iv) Eraser Tool – This tool helps you to rub the object 
you have drawn by mistake.
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Computer Wizard  - 3

Chapter – 1 : Computer Fundamentals

1. Tick (✓) the correct answer :

a. all of these b. mouse

c. memory unit d. Thin Film Transistor

e. Hard Disk

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✓

c. ✗ d. ✓

e. ✓

3. Match the following :

a. (iv) b. (vi)

c. (i) d. (ii)

e. (iii) f. (v)

4. Fill in the blanks :

a. IPO b. Software

c. CPU d. Control Unit

e. Input f. Storage

5. Who am I?

a. CPU b. PRINTER

c. MONITOR d. ALU

e. CONTROL Unit f. DVD

6. Give the full form of the following :

a. Control Unit

b. Digital Versatile Disk

c. Central Processing Unit

d. Compact Disk

e. Input Process Output

f. Arithmetic and Logical Unit

7. Answer the following questions :

a. A computer has the following characteristics:-

• Speed • Accuracy

• Reliable • Diligent

b. Input Devices are used to enter data and instructions. For 
example, keyboard, mouse, scanner, microphone are input 
devices.
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c. The different actions that can be performed with a 
computer mouse are :-

• Left – click • Right – click

• Double – click • Drag  and drop

d. CPU is made up of three main parts. They are-

•   Arithmetic and Logical Unit (ALU)

•   Control Unit (CU)

•   Memory Unit (MU)

e. Hardware : Hardware refers to the physical parts of a 
computer that you can touch and feel. Example- keyboard, 
CPU etc.

Software :  A set of instructions given to the computer to 
perform a given task is called a computer program or 
software. For example MS Paint, Notepad, Microsoft 
Word.

f. The devices used to storing data are known as secondary 
storage devices or storage media. Example- hard Disk, 
CD, DVD, etc.

Chapter – 2 : Types of Computer

1. Tick (✓) the correct answer :

a. Charles Babbage b. Abacus

c. mainframe computer d. binary language

e. processing

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✓ d. ✗

e. ✓

3. Fill in the blanks :

a. electronic b. Special purpose computer

c. Charles Babbage d. Micro computer

e. Super computer

4. Choose the correct answer based on the functions of 
computer :

a. Memory b. ALU

c. Input d. Output

e. CPU
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5. Identify the type of computer :

a. Micro Computer b. Super Computer 

c. General purpose Computer

d. Mini Computer e. Super Computer 

6. Give the full form of :

a. Central Processing Unit

b. Arithmetic Logical Unit

c. Uniterrupted Power Supply

d. Control Unit

7. Answer the following questions :

a. Computer is an electronic machine which is made up of 
many devices that helps in accepting data and orders from 
us and gives results as output after processing.

b. The main units of computer are- Input unit, Processor, 
ALU and CU, Memory unit, Output unit.

c. Based on the size computer can be categorized as:

•   Micro Computer

•   Mini Computer

•   Mainframe Computer

•   Super Computer

d. Machine language is the language based on binary 
numbers (0 and 1), which can be understood by computer 
directly.

e. The steps to shut down the computer are as : 

•   Click on Start button 

•   Select shut down option from list.

•   Click on shut down button

•   Click OK wait for sometimes, till the power turns off,   
then press the button of UPS.

Chapter – 3 : Uses of Computer

1. Tick (✓) the correct answer :

a. school b. operation

c. booking tickets d. keeping accounts

e. all of these

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✗



c. ✓ d. ✓

e. ✓

3. Fill in the blanks :

a. money b. ATM’s

c. press d. computer

e. easily

4. Answer the following questions :

a. Computer has the ability to do different types of works 
like :

•   Writing •   Calculating

•   Drawing •   Designing

•   Mainting records •   Controlling other system

b. Computers are used in school, bank, hospitals, railway 
stations, office, and home.

c. (i) Banks – Record of money can be kept on a computer.

 • Record of customer is maintained on a computer.

• ATMs are controlled by a computer.

• (ii) Railyway Station- Railway tickets are printed using a 
computer.

• Records of passangers and trains can be kept on a 
computer.

(iii) School- You can learn new things on a computer.

• Students record can be kept on a computer.

(iv) Printing Press-to create and design books and 
newspaper.

• To gather news from different places.

(v) Hospitals- Medical reports can be made on a 
computer.

• Records of doctors and patients can be kept on 
computer.

e. To learn new things.

• To gather information about different topics.

• To play games.

Chapter – 4 : Computer Hardware

1. Tick (✓) the correct answer :

a. hardware b. MU
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c. enter key d. printer

e. processing device

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✓

c. ✓ d. ✗

e. ✗

3. Fill in the blanks :

a. soft copy b. printouts

c. hard copy d. speaker

e. CPU f. storage

4. Give the use of following in one sentence :

a. Mouse – Mouse is the pointing device, use to perform 
different actions like select, open, draw or move the 
object on the scree.

b. Keyboard- Keyboard is the device with many types of 
keys, we can press them and send the data to the computer.

c. Microphones-Microphone is a device mainly used to 
enter/ record sound in the computer.

d. Monitor – Monitor is used to show the output on the 
screen as a soft copy of the result.

e. Printer- Printer is used to show the output on the paper as 
a Hard Copy of the result.

f. The speakers are used to give sound as the output.

5. Name any one device of the following category :

a. Input Device – Keyboard 

b. Processing Device – CPU

c. Storage Device – CD

6. Name the following :

a. Space Bar b. /

c. Left Mouse Button d. +

7. Answer the following questions :

a. Computer Hardware comprises of that part of computer 
which we can see and touch. For example Keyboard, 
Mouse, Speakers etc.

b. Input Devices, Output Devices, Processing Devices, 
Storage Devices.
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c. The various actions of mouse are-

•   Pointing •   Click

•   Double click •   Drag

d. Processing devices help the computer to work on 
(process) the input and show the output. Example- CPU.

e. Storage devices help the computer to save or store the 
data and processed results, so that they can be used 
further: Example- Hard Disk, CD.

Chapter – 5 : Computer Software

1. Tick (✓) the correct answer :

a. all of these b. Software

c. Word-Pad d. MS-Paint

e. software

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✓

c. ✓ d. ✓

e. ✓

3. Fill in the blanks :

a. directs b. hardware

c. Language of Graphic Oriented

d. Microsoft Disk Opearting System

4. Give a sentence about the following software :

a. Virus – Software which damages other programs, or 
normal working of the entire computer.

b. MS-Paint- Software is used to draw, colour different 
figures.

c. LOGO- LOGO helps you to build programs for drawing 
pictures, writing text, doing calculations.

d.  Notepad- Software is used to write and edit text.

e. MS-DOS – is a single user, single tasking computer 
operating system that uses command line interface.

5. Answer the following questions :

a. Software and Hardware are needed to make the computer 
functional.
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b. Computer Software is a set of instructions, data or 
programs used to operate computers and execute specific 
tasks.

c. Software is of two types : 

(i)  System Software 

(ii) Application Software

d. (i) WordPad - Software is used to write and edit text. 

(ii) Solitare - Software to play game using the cards of   
four different types.

(iii) MS Paint : Software is used to draw, colour different 
figures. 

(iv) MS DOS : MS DOS is a single user, single tasking 
computer operating system that uses command line 
interface. 

e. LOGO – Language of Graphic Oriented

MSDOS – Microsoft Disk Operating System.

Chapter – 6 : Operating System

1. Tick (✓) the correct answer :

a. operating system b. both (i) and (ii)

c. single user d. instructions

e. computer

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✗ d. ✓

e. ✗

3. Fill in the blanks :

a. Machine language b. Computer language

c. Operating system d. Single user OS

e. GUI

4. Define the following :

a. Windows – Windows is a graphical operating system 
developed and published by Microsoft.

b. Operating System- OS is the interface between the 
computer hardware and the user. 
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c. Single User- Single user OS can be used by one user at a 
time.

d. Multi User – Multiuser allows can work on it altogether.

5. Give the full form of following :

a. OS – Operating System b. DOS – Disk Operating System

c. GUI – Graphic User Interface

6. Answer the following questions :

a. Operating system OS is the interface between the 
computer hardware and the user.

(i) DOS (Disk Operating System)

(ii) Windows 16 a

b. Types of operating system are single user OS & Multi 
user OS

c. Operating system is a system software.

d. The other name of Windows OS, is GUI.

e. (i)   Managing files

      (ii) Checks various devices such as printers, monitors etc.

Chapter – 7 : Welcome to Windows 10

1. Tick (✓) the correct answer :

a. icons b. desktop

c. desktop d. folder

e. Title bar

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✓ d. ✓

e. ✓

3. Fill in the blanks :

a. user and computer b. loads

c. desktop d. icon

e. programs

4. Give the use of the following Windows OS :

a. Maximize button – It expands the window in the entire 
desktop screen.
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b. Icons – The small pictures on the desktop are called icons.

c. Task bar- Taskbar displays the names of all the open 
windows as buttons. The Taskbar always contains the 
Start button, Quick Launch Bar and the System Tray.

d. Maximize button – It expands the window in the entire 
desktop screen.

e. Scroll Bar- This is the bar shaped box. It consists of: 

(i) Two small pointed arrows (ii) Scroll Buttons

f. Minimize Button- It reduces the size of the software 
Window and displays it in the task bar.

5. Answer the following questions :

a. MS – Windows is Graphic User Interface (GUI) based OS. 
It has small pictures called icrons. 

•   It is easy to learn and use.

•  It allows you to work on many programs at the same  
time.

b. The process of loading the operating system when a 
computer is switched on is called booting.

c. The small pictures on the desktop are called icons. Some 
of the common icons on the desktop are:

•   My Computer

•   My Documents

•   Recycle Bin

d. Taskbar – The taskbar is located at the bottom of the 
Desktop. Taskbar display the names of all the open 
windows as buttons. The Taskbar always contains the 
Start button, Quick Launch Bar and the System Tray.

e. (i) Menu bar- It displays the list of all the facilities 
provided by the software. All the software windows may 
have menus like: File, Edit, View, Help along with few 
other menus.

(ii) Tool Bar:- It consists of small graphical icons 
representing the specific action for a software window.

(iii) Work Area- This is the area which is actually 
provided for the different types of work for which the 
software is designed for.
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Chapter – 8 : Introduction of WordPad

1. Tick (✓) the correct answer :

a. software b. all of these

c. close button d. ctrl + s

e. menu bar

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✓

c. ✓ d. ✗

3. Fill in the blanks :

a. font box b. font colours

c. Bold d. Font size

e. Underline

4. Answer the following questions :

a. WordPad is a software which can be used to create text 
documents. It is a word processing software.

b. Steps to start WordPad are - 

•  STEP 1 – click on Start button.

•  STEP 2 – click on Programs.

•  STEP 3 – click on Accessories.

•  STEP 4 – click on WordPad.

c. The main parts of WordPad documents are work area, 
menu bar, standard toolbar, formatting toolbar.

d. The steps to save the file in WordPad are_

•   Click on save icon, a box will appear.

•   Give the file name

•   Click on save.

5. Write short note on :

a. Font box- Font box helps us to type the text in different 
ways. It shows the list of many writing styles. You can 
select them from its list.

 b. Font style are used to display the text in different styles 
like:-

•   Bold icon to turn the text in dark shade.

c. New - This icon helps you to create a new WordPad file.

d. Open - The icon helps you to open your previously 
created file in WordPad.



e. Save - This icon helps you to store your WordPad file in 
the computers memory.

Chapter – 9 : Introduction of LOGO

1. Tick (✓) the correct answer :

a. Language of Graphic Oriented 

b. main screen

c. status button 

d. halt button

e. reset button

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✓ d. ✗

e. ✓

3. Fill in the blanks :

a. work b. pen, triangle

c. commands d. Command list

e. input

4. Name the following :

a. Main screen, Commander Window

b. Command list box, Command Button, Input Box

5. Answer the following questions :

a. LOGO is a simplest computer language. It stands for 
Language of Graphic Oriented. It is used to draw figures, 
type text and perform arithmetic calculations.

b. Uses of LOGO – LOGO can do lots of work for you. It is 
used to:

•   Draw pictures: simple shapes and patterns.

•   Write: writing text

•   Do calculations

•   Perform simple logical operations.

c. How to start LOGO- To start LOGO you must follow the 
following procedure- 

•   STEP 1 – Click on Start button.

•   STEP 2 – Click on Programs option.

•   STEP 3 – Click on Microsoft Windows LOGO

•   STEP 4 – Click on Microsoft Windows LOGO
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d. LOGO screen is broadly divided into two parts:

•   Main Output Screen : This part of the screen shows the 
result of your instructions. All small pictures, patterns, 
text, calculation results are shown on it. This screen 
consists of turtle which shows your position on the 
screen.

•   Commander window : This consists of all the tools you 
need to give commands to the turtle, in order to 
complete the desired task. It has many parts like:

    1.   Command List Box

    2.   Input Box

    3.   Command Button

e. Debugging- is the process of correcting the mistakes from 
the program.

Chapter – 10 : Writing in  LOGO

1. Tick (✓) the correct answer :

a. PR b. graphic

c. enter key d. input box

e. commander window

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✓

c. ✗ d. ✓

3. Fill in the blanks :

a. commands b. Syntax

c. PR d. CT

e. Symbols

4. Complete the syntax in following :

a. PRINT [text] or PR [Text]

b. CT Command

5. Give one word for the following :

a. Input box b. Commander window

d. No e. Print

6. Answer the following questions :

a. Syntax refers to the rules that define the structure of a 
language.
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b. Print or PR logo command is used to type text in LOGO.

c. Two special symbol are used to type text in LOGO. They 
are square bracket[ ] or double quotes. [“”]

d. CT or CLEAR TEXT command is used to clear the 
contents of commander list box.

e.  PR  

(i)  Its full form is Print 

(ii) It needs one input For example :

PR [input]

PR [hello]

(iii) It displays the text which you give with it.

(iv) It needs symbols like [ ] or “” to accept the input.

CT

(i)  Its full form is CLEAR TEXT 

(ii) It doesn’t need any input CT

(iii) It clears the list box screen.

 (iv) It doesn’t need any symbol.

Chapter – 10 : Calculation in LOGO

1. Tick (✓) the correct answer :

a. SUM b. PRODUCT

c. QUOTIENT d. PR

e. input box

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✗ d. ✓

 e. ✗

3. Fill in the blanks :

a. calculations b. QUOTIENT

c. * (asterisk) d. division

e. arithmetic

4. Answer the following :

a. The operators used to do calculations in LOGO are:-

•   Addition (+) •   Subtraction (–)

•   Multiplication (*) •   Division ( / )
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b. All the commands has to be given in INPUT BOX of 
LOGO screen.

c. (*) symbol is used to perform multiplication and ‘/’ is 
used to perform division.

d. (i) SUM – This LOGO command is used to add different 
numbers.

(ii) PRODUCT – This command is used for multiplying 
different input numbers.

(iii) QUOTIENT- This LOGO command is used to divide 
two numbers.

e. To perform calculation in LOGO we have the following:-

Syntax- PR first number OPERATOR second number OR

PR calculation COMMAND first number second number.

Chapter – 11 : Drawing in LOGO

1. Tick (✓) the correct answer :

a. CS  b. FD

c. CT d. BK

e. LT

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✓ d. ✗

e. ✗

3. Fill in the blanks :

a. HOME b. CS

c. RT d. BK

e. FD

4. Write the use of following LOGO commands in short-

a. RT – This command tells the turtle that it has to take the 
right turn.

b. FD- This command tells the turtle that it has to move in 
forward direction.

c. HOME – This command sends the turtle to its original 
position.

d. CS – This command erases the drawing on the main 
screen and make it ready for new drawing.
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e. LT – This command tells the turtle that it has to take the 
left turn.

f. BK – This command tells the turtle that it has to move in 
backward direction.

5. Give the LOGO commands for the following actions :

a. FD 60 b. BK 80

c. RT 50 d. HOME

e. CS

6. Answer the following questions :

a. LT- Full form of LT is LEFT turn. This command tells the 
turtle that it has to take the left turn.

d. Enter button should be clicked to run a command.
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Computer Wizard  - 4

Chapter – 1 : Evolution of Computer

1. Tick (✓) the correct answer :

a. Abacus  

b. ENIAC

c. Ultra Large Scale Integration

d. Transistors

e. Fifth Generation Computer

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✓

c. ✗ d. ✓

e. ✓

3. Fill in the blanks :

a. Napier’s Bone b. Pascaline

c. First d. Charles Babbage

e. Analytical Engine

4. Name the following :

a. Abacus b. Pascaline

c. Mark 1 d. Charles Babbage

5. Write the full form of :

a. Large Scale Integration

b. Very Large Scale Integration

c. Ultra Large Scale Integration

d. Integrated Circuit

e. Electronic Numerical Integrator And Calculator

6. Answer the following questions :

a. (i) Abacus – It consists of:

• Roads

• Beads / Balls- They are of two types-

• Heaven Bead

• Earth Bead

(ii) Napiers – It consists of number of rods called 
Napier’s Bone.

(iii) Pascaline- It consists of Toothed Wheel and Gears.



b. There are five Generations of Computer :

• First Generation Computers (1942-1955) 

• Second Generation Computers (1956-1965)

• Third Generation Computers (1966-1975

• Fourth Generation Computers (1976-1985)

• Fifth Generation Computers (1986-till date)

c. The size of computers in the successive generations is 
decreasing gradually, this is because in every new 
generation new component was used and it finally 
reduced the size of the computers.

d. (i) Third generation computers – Main features are- 

1. Size : Much smaller

2. Main Components : Integrated Circuits

3. Storage : Magnetic Disk, Drums, Tapes

4. Cost : Comparative Low cost

5. Examples : IBM 360, PDP11, CRAY 1

(ii) Fifth generation computers – Work is going on to 
inculate intelligence in the computers. Main features 
are :-

1. Size : Small 

2. Main Components : VLSI (Very Large Scale 
Integration)

ULSI (Ultra Large Scale Integration)

3. Storage : Magnetic Disks, drives etc

4. Cost : Comparative low cost

5. Examples : Robots etc.

Chapter – 2 : Computer Peripherals

1. Tick (✓) the correct answer:

a. Input device b. Scanner

c. Output device d. Keyboard

e. Plotter

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✓

c. ✗ d. ✓

e. ✗
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3. Fill in the blanks :

a. peripherals b. Input/ output

c. Mouse Pad d. Input and Output

e. digital

4. Give the full form of :

a. VDU – Visual Display Unit

b. CRT – Cathode Ray Tube

c. LCD – Liquid Crystal Display

5. Give the functions of following :

a. Speaker- Thsese devices are used to give the sound output 
from the computer.

b. Plotter – This is the device used to give high quality 
graphical outputs.

c. Keyboard- It helps us to enter data in the computer.

d. Modem- This device can be used both as input device or 
output device. It is used to bring or send data through 
internet.

e. Scanner – This is the device used to copy or accept the 
image from the page or document to the computer.

f. Joystick- It is generally used to play games.

6. Match the following :

a. To copy image from the paper to the computer.

b. Move in all four directions.

c. Bar code Reader, light pen, OCR

d. Give soft copy.

e. Impact and Non Impact

7. Answer the following questions :

a. The devices designed to accept the input from the user 
and send it to processor are known as input devices. Eg. 
Keyboard, Mouse, etc.

b. Output devices are the devices that shows the processed 
information or result to the user. Eg- Monitor, Printers, etc.

c. Mouse can be of different types like:-

•   Scroll Mouse •   Roller Mouse

•   Optical Mouse •   Cordless Mouse

d. (i) This output shown on the monitor screen is known as 
Soft copy.
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(ii) The output given by the printer on the papers is 
known as Printout or Hard Copy.

e. Printer is used to show the output on papers. Two types of 
printers are- Impact Printer and Non Impact Printer.

Chapter – 3 : Storehouse of Computer

1. Tick (✓) the correct answer :

a. Monitor b. RAM

c. Hard disk d. Floppy Disk

e. Primary

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✓

c. ✓ d. ✗

 e. ✗

3. Fill in the blanks :

a. Storage b. Bits and Bytes

c. Binary digit d. Byte

e. Byte

4. Match the following :

a. 1024 Bytes b. 1024 KB

c. Giga Bytes d. Tera Byte

e. 8 BIT f. Hard Disk

g. Compact Disk h. Floppy Disk

5. Give the full form of the following :

a. Random Access Memory

b. Read Only Memory

c. Compact Disk Read Only Memory

d. Floppy Disk Drive

e. Hard Disk Drive

6. Name the devices :

a. Hard Disk b. Floppy Disk

c. Magnetic Tape d. Pen Drive 

e. Hard Disk f. CD

g. ROM h. RAM

7. Answer the following questions :

a. Memory unit can be two basic types:

•   Primary Memory •   Secondary Memory



b. Primary memory is a small capacity memory unit of 
computer. It can hold the data for short period. The data 
stored in it is kept here for temporary use. It is also 
known as Main Memory or Internal Memory.

•   ROM - Read Only Memory 

•   RAM - Random Access Memory

c. Secondary memory unit is the group of storage devices 
which can be used to store the data, information and 
software permanently. There are many secondary storage 
devices used in computer. Few secondary memory devices 
are: Hard Disk, CD, DVD, Floopy Disk etc.

d. (i) ROM – Read Only Memory is an essential component 
of the memory unit. ROM contains of all the instructions 
needed by computer when it is switched on. The memory 
is permanent and not erased when the system is switched 
off.

(ii) RAM – Random Access Memory (RAM) is temporary 
and is erased when the computer is switched off or power 
supply is stopped. Whatever you do on computer, that 
data is kept temporaily in RAM. You can read as well as 
write the data in RAM.

e. (i) Bit – Bit stands for Binary digit. It is single digit in a 
binary number which can be either 0 or 1. Bit is the 
smallest unit of data in a computer.

(ii) Byte –The group of 8 BITS is known as a BYTE. 
Byte is considered as the smallest unit of memory.

Chapter – 4 : Computer Software

1. Tick (✓) the correct answer :

a. Software b. Windows

c. COPY d. GUI

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✓ d. ✗

e. ✓

3. Fill in the blanks :

a. Software b. Computer program
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c. Software d. Application

e. Disk Operating System

4. Match the following :

a. Hardware + Software b. System Software

c. Application Software d. GUI

e. MS DOS f. Makes Programs

5. Answer the following questions :

a. Software are the group of programs given to use the 
computer in different manner. There are different types of 
software in the computer system.

1. System Software -  Software which controls the 
working of the hardware.

2. Application Software – Software made for different 
types of work like painting, writing etc.

b. Operating system is the interface between the user and the 
machine which manage the working of the entire 
computer system and make it ready to do the work.

The two common Operating Systems are:

•   DOS •   Windows

 c. DOS is an operating system, where you have to type the 
commands to get any work done by the computer. DOS 
consists of list of commands which are given according to 
the requirement.

d. Windows- This is the operating system represented by the 
programs and files with small graphical pictures, which 
can be controlled by mouse as well as keyboard. Since it 
is supported by graphical pictures so it is also known as 
GUI (Graphical User Interface) Windows are available in 
different versions like:

WINDOWS 3.1

WINDOWS 95

e. OS -Operating system can provide us the following:-

•  A background to work with the computer system.

•  A middle layer between the machine and the user. It can 
interact with computer.

•  A media of communication with the machine.

•  Recognizing input from the keyboard.
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•  Sending output to the display screen.

•  Controlling peripherals devices such as disk drives and 
printers.

f. Flowcharts are the pictorial representation of sequence of 
steps planned for a Program.

Chapter – 5 : Working in Windows

1. Tick (✓) the correct answer :

a. Windows Desktop b. Icon

c. Folders d. Right Pane

e. Unique

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✓

c. ✓ d. ✗

e. ✗

3. Fill in the blanks :

a. Window Explorer b. Startup Menu

c. Shut Down d. Recycle Bin

e. Secondary

4. Give the extensions of the following :

a. .txt b. .doc

c. .bmp d. .gif

e. .xls

5. Define the following :

a. Desktop – It is the opening screen of Windows. This 
screen provides the background to the Operating system.

b. Icons – These are the small graphical pictures or symbols 
which represent one program or software. It is present on 
the desktop, as well as in other menus of the Opearting 
System.

c. Programs -  Shows list of programs that run on the 
computer.

d. File – A file is a collection of data stored under one name 
in the computer memory.

6. Answer the following questions : 

a. Microsoft Windows is a powerful operating system that 

38



control overall activity of the computer. It is powerful and 
widely in use because of the following main reasons:-

•  It holds many useful programs that store your important 
files.

•  You can run a program by selecting its picture (called 
icons).

•  It is possible to move from one software to another , if 
more than one software is open on your screen.

•  View and organize your files and directories in a simple 
manner.

•  Easy to learn and use.

b. The main components of Windows Operating System are 
Desktop, icons, taskbar, system tray and start button.

c. Taskbar- This is the bar at the bottom of the desktop. It 
has mainly:

•   Start button

•  All the programs names which are stored on the

   computer.

•  System tray. It may consist of:

    Date/ Time box

    Icons of some services that may be executing on the

    background.

d. First click on properties option: The Background option of 
the desktop. List of different wallpapers are given in the 
List, choose the design and click on OK, new wallpaper 
will be set on desktop.

e. Windows Explorer is a powerful program which helps you 
to organize file and folders in an efficient manner.

It helps us to do the following operations on the files and 
folders :

•  Create a file

•  Rename it

•  Open when needed

•  Copy

•  Move from one position to another

•  Delete when not required

39



f. Following steps can help you to create a new folder First 
Right click on the blank area on the desktop or in 
Windows Explorer.

Click on New option from the menu displayed.

Click on folder option from the list of menu displayed.

7. a. First click on properties option: The Background option of 
the desktop. List of different wallpapers are given in the 
List, choose the design and click on OK, new wallpaper 
will be set on desktop.

b. To set the Screen Saver click on Screen Saver tab from 
the properties window, the screen changes to the Screen 
Saver.

The list of screen saver is given:

Choose the design and click on OK.

To see how it looks click on the Preview option.

c. Following steps can help you to create a new folder First 
Right click on the blank area on the desktop or in 
Windows Explorer.

Click on New option from the menu displayed.

Click on folder option from the list of menu displayed.

d. In Windows Explorer Click on the folder. Click o Copy 
icon from the menu bar.

Double click on the folder, where you want to move the 
content.

Click on Paste icon from the menu bar.

e. (i) Click on Start menu 

(ii) Click on Accessories

 (iii) Click on All programs 

(iv) Click on Paint program

Chapter – 6 : Microsoft Office Word

1. Tick (✓) the correct answer :

a. Word processor b. all of the above

c. Title bar d. moving text

2. Tick (✓) the correct statements and cross (✓) the wrong ones:

a. ✓ b. ✓
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c. ✗ d. ✓

e. ✓

3. Fill in the blanks :

a. MS-Word b. Title Bar

c. Editing d. Copy

e. Ctrl + Z

4. Define :

a. Ribbon – It gives you all the options to work from a 
single area.

b. The office button – The commonly used commands like to 
open, save and print documents are stored here.

c. Title Bar – It displays the name of the document.

5. Write the steps : 

a. To move the text- To move the text:

•  Select the text which you want to move.

•  Click on the Home Tab.

•  Click on the cut button.

• Bring the cursor of the position where you want to 
paste it.

• The selected text will move the cursor position.

b. To copy the text- To copy the text:-

• Select the text which you want to move.

• Click on the Home tab.

• Click on the copy button.

• Bring the cursor to the position where you want to 
paste it.

• Click on the paste button.

• The selected text will get copied at the cursor position.

c. To save the file- To save the file:

• Click on the office button

• Select the save option

• The save as dialog box opens

• Enter the name for the file

The file will be saved. You will see the name of the file in 
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the title bar of the MS Word. You can also click on the 
save icon on the Quick Access toolbar.

d. To open the saved file- To open the saved file:-

• Click on the office button

• Select the open option

• The open dialog box gets displayed

• Select the file to open.

e. To open a new file- To open a new file-

• Click on the office button

• Select the New option

• A new blank screen will open.

f. To print the file- To print the file:-

• Click on the office button

• The print dialog box will open

• Select the print option

• Enter the number of copies you want to print.

• Click on the OK menu.

6. Answer the following :

a. Microsoft Office Word (Commonly Known as Word) is a 
Word Processor from the Microsoft Company. It  is a part 
of Microsoft Office Suite. MS Office is a complete office 
management software. To open Microsoft office word :-

• Click on the start button.

• Point to program

• Point to Microsoft Office

• Click on the Microsoft Office word. Blank screen of 
Microsoft Office Word will open.

b. This property of the text wrapping itself to the next line 
when it goes past the right margins is called the word 
wrap.

c. A paragraph is a portion of the text typed continuously 
without pressing the Enter key. When you press the Enter 
key, the insertion point will jump to the new line and a 
new paragraph will start.

d. To use spell check to correct spelling mistakes:-

• Right click on the mis-spelt word. (A red wavy line 
under it will appear.
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• A pop-up menu will appear with the suggestions for the 
mis-spelt word. Click on the suggestions which you 
think is correct.

e. To exit form Word :

• Click on the office button and select the Exit word 
option. Word will close.

Chapter – 7 : Features of MS Word

1. Tick (v) the correct answer :

a. formatting b. font

c. all of the above d. Word Art

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✓ b. ✗

c. ✓ d. ✓

e. ✗ f. ✗

g. ✓ h. ✓

3. Fill in the blanks :

a. font size b. numbering

c. Italic d. bigger

e. Word Art

4. Write the steps :

a. To align the text :

•  Click on the paragraph which you wany to align.

•  Click on the required alignment button.

The typed text will get aligned accordingly.

b. To create the bulleted list:-

•  Click on the Home tab.

•  Click on the Bullets arrow head.

•  Select the bullet type.

•  That bullet will appear at the cursor position. Types the  
text and press the enter key.

•  The next bulleted point will appear.

c. To create the numbered list :-

• The ordering of the items in a numbered list is important.
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• Click on the Numbering arrowhead.

• Select the Numbering type.

d. To insert the ready made shape:-

• Click on the insert menu.

• Click on shape button it will show line, basic shapes, 
Arrows and flowchart and callouts etc.

• Choose any one shape and drag it into where you want 
to insert a shape.

5. Answer the following questions:

a. Formatting is the way to improve the appearance of the 
text to make it look beautiful, arranged and systematic.

b. A font is the design of the characters which you type : By 
changing the font size, the text can be made bigger or 
smaller in size as required. 

c. Numbering is applied to paragraph when the ordering of 
items is important.

d. Bullets are applied to paragraphs when the ordering of 
items is not important.

e. Left Alignment – In left alignment, the typed text aligns 
to the left margin.

Right Alignment – In Right alignment, the typed text 
aligns to the right margin.

Center Alignment 

Justified Alignment.

Chapter – 8 : LOGO -1

1. Tick (✓) the correct answer :

a. graphics b. primitives

c. forward d. moves backward

e. LT

2. Tick (✓) the correct statements and cross (✗) the wrong ones:

a. ✗ b. ✗

c. ✓ d. ✗

e. ✓
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3. Fill in the blanks :

a. O and 1 b. BBN

c. turtle d. PAINT

e. Set Head f. PE

4. Match the following :

a. FORWARD b. BACK

c. RIGHT TURN d. LEFT TURN 

e. PEN DOWN f. PEN ERASE

g. PEN PAINT h. SET HEAD

6. Differentiates between the following :

a. PU- (PENUP) Helps the turtle to move on screen without 
drawing a line.

PD – (PEN DOWN) This is the opposite of Penup. It 
enables the turtle to draw lines again.

b. ST – (SHOW TURTLE) It helps the turtle to reappear on 
the screen.

HT – (HIDE TURTLE) HT command disappear the turtle 
from the screen.

c. FD – (FORWARD)- To move the turtle forward as per 
specified points.

BK (BACKWARD)- To move the turtle backward as per 
specified points.

d. RT ((RIGHT TURN) – To turn the turtle Right.

LT – (LEFT TURN)- To turn the turtle Left.

7. Answer the following questions :

a. LOGO is the simplest computer language. It stands for 
Language of Graphic Oriented, sometimes it is also 
known as Logic Oriented Graphic Oriented. It was used as 
a functional programming language. LOGO can be used 
for the following main purposes:-

• You can draw simple shapes, figures, patterns and 
designs.

• You can do arithmetic calculations such as addition, 
subtraction, multiplication and division.

• You can also display text messages using LOGO.
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b. Starting MSW LOGO – 

• Step 1 click on Start Button

• Step 2 click on Program Option

• Step 3 click on Microsoft Windows LOGO

• Step 4 click on Microsoft Windows LOGO Sub 
Option.

c. Small triangle in the center of the Graphic screen is called 
the turtle. The turtle represents the cursor in LOGO. It 
shows the position on the screen where your instructions 
will be carried out. It moves on the screen according to 
your instructions. The top pointed end of the turtle is 
called its head. The bottom wide base of turtle is called its 
tail. 

d. LOGO commands can be:-

• Action Commands -  Those which shows some action 
on screen whem they are given for example FD, BK, 
LT, RT etc.

• Control Commands – Those which control some 
group of commands for eg. REPEAT.

e. A LOGO program is a set of primitives (command/ 
instructions). Eg- FD, BK, RT, etc.

Chapter – 9 : LOGO -2

1. Tick (3) the correct answer :

a. PRODUCT

c. TO AND END

d. LOAD

e. SHOW LOWER CASE

2. Tick (3) the correct statements and cross (7) the wrong ones:

a. 3 b. 7

c. 7 d. 3

e. 7

3. Fill in the blanks :

a. PR b. TO END

c. Procedure d. .LGO

e. FIRST f. Primitives
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5. Give the Outputs for following LOGO Commands :

a. PR [HELLO I AM IN THE SCHOOL] 

HELLO I AM IN THE SCHOOL

b. PR [MY NAME IS PRIYA]

MY NAME IS PRIYA

c. PR [2+2+5+8] 

17

d. PR PRODUCT [4 5]

20

6. Write the functions of following commands :

a. PR – This command prints the text given with it in the 
output.

b. SHOW UPPERCASE – This change the text in the 
Capital alphabet.

c. LAST – This command displays the last word of the 
whole text.

d. SHOW LOWERCASE – This change the text in the Small 
alphabet.

e. SUM – This is used to add the given numbers.

f. PRODUCT – This is used to multiply the given numbers.

g. TO PROCEDURE NAME – These commands is used to 
create a LOGO procedure.

7. Answer the following questions :

a. FIRST – This command displays the first word of the 
whole text. 

LAST – This command displays the last word of the 
whole text.

SHOW LOWER CASE – This change the text in small 
alphabet. 

b. You can do calculations in LOGO program in two ways:-

• You only need to specify the number with the 
required opearators like +, -, *, /.

• You can give the key words to perform calculations.

Calculating using Key terms- Some words are understood 
by the LOGO based on which it can perform calculations. 
The terms are :
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• SUM – This is used to add the given numbers.

• PRODUCT – This is used to multiply the given 
numbers.

c. Set of LOGO command or instructions given to the turtle 
is known as LOGO Procedure.

It shows following main features:

• Procedure has group of LOGO commands.

• Procedure is saved with a name.

• Procedure is defined by using TO and END command.

• Procedure can be saved in the Computer memory for 
further use.

d. Save command tells the computer that the specified 
LOGO procedure has to be saved in Computer memory 
for further use. It is given as :

• SAVE “filename. LGO

• SAVE “square. LGO

• .LGO is the extension of LOGO files.

e. LOAD command is used, it will bring the file from the 
secondary memory unit to RAM (Random Access 
Memory) it is given as

• LOAD “filename.LGO

• LOAD “square.LGO

Chapter – 10 : The Internet Application

1. Tick (3) the correct answer :

a. www c. web page

d. internet e. search engine

2. Tick (3) the correct statements and cross (7) the wrong ones:

a. 3 b. 7

c. 3  d. 7

 e. 7

3. Fill in the blanks :

a. Internet b. web browser

c. search engine d. e_mail

e. chatting

4. Define :

a. Website – A website is a collection of web pages.
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b. Web page- A web page is a digital page containing 
information in the form of text, picture, video and sound.

c. URL – The address of the Internet document in order to 
access it is called the URL.

d. Search Engine – A Search Engine is a website designed to 
search for information on the world wide web. Eg: 
www.google.com.

e. E-mail – It is the electronic way of sending mails using 
the Internet as a medium. We can send text, audio, video 
and animation files using the e-mail.

5. Write the steps :

a. To open the Google Chrome – Double click on the icon 
on the Desktop. The Google Chrome window will open.

b. To open a Website by entering its URL – To open a 
website by enteing its URL. 

•  Enter the URL of the website in the Address bar.

•  Click on the go button.

c. To write and send an e-mail – To write and send an e-mail

•  In the To box, write the Receiver’s e-mail.

•  In the Subject box, write the topic of message.

•  In the message box, write the message.

•  Clickon the send button.

d. To open and read the e-mail message – To open and read 
the e-mail message:-

•  Login to your e-mail account.

•  Click on the inbox folder.

•  Click on the e-mail.

•  The e-mail message will open.

6. Answer the following questions :

a. The INTERNET is the largest network in the world 
connecting millions of people world- wide.

The Internet consists of following applications :

•  World Wide Web (www)

•  E-mail

•  Chatting
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b. The world wide web (www) is a graphical part of the 
Internet consisting of text, pictures, sound and video.

c. (i) E-mail provides faster and easy means of 
communication.

      (ii)  E-mail is free tool.

    (iii)  Email is accessible from anywhere.

d. E-mail : It is the electronic way of sending mails using 
the Internet as a medium. We can send text, audio, video 
and animation files using the e-mail. While In chatting 
you can type a message that will be read by the person 
who is on the other end and that person will reply to your 
message instantly.

e. A web browser is a software application which makes it 
possible for a user to display and interact with text, 
images, video, music and other information available on a 
web pages. Using a web browser you can easily navigate 
between the opened web pages and save it in various 
formats. Eg. Google, Chrome, Opera 
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Computer Wizard  - 5

Chapter – 1 : Classification of Computer

1. Tick (3) the correct answer :

a. Micro computer b. Embeded computer

c. Super computer d. none of these

e. Mainframe computer

2. Fill in the blanks :

a. size and performance b. VAX 8842 and CDC 6600

c. PARAM d. Personal Digital Assistant

e. Washing machines and television

3. Write True and False :

a. True b. True

c. True d. True

e. False

4. Arrange the following computers according to their 
processing power:

a. Micro computer b. Mini computer

c. Mainframe computer d. Super computer

5. Answer the following questions :

a. Based on their size and performance computers can be 
classified into the following types :

•  Micro Computers

•  Mini Computers

•  Mainframe Computers

•  Super Computers

b. Personal Computer 

(i)  This is single user system

(ii) It has small storage capacity. Example- Laptop

(iii) They are used in offices and homes.

Mini Computer

(i)    These is multiuser system. 

(ii)   It has large storage capacity. Example – PDP-11 



(iii) They are used for scientific and engineering 
computation. 

c. Super Computers- Super computers are the most powerful 
of all computers. They are also the most expensive 
computers. They are very powerful and fast. Super 
computers are used in places for weather forecasting, 
nuclear science, and seismology. PARAM is the super 
computer which has been designed in India.

d. Laptop Computer- Laptop computers are highly portable 
and allows to use computer almost anywhere. Laptop 
computer take up less room on a table and can be put 
away when not in use.

e. When a computer is used to run another machine or 
appliance, it is known an embedded computer. There are 
present in almost all gadgets like washing machines, 
watches, televisions and even cars.

f. Personal Digital Assistant is a term for small mobile, 
handheld device that provides computing and information 
storage and retrieval capability for personal or business 
use.

Chapter – 2 : Languages of Computer

1. Tick (3) the correct answer :

a. 1 byte b. machine language

c. virus d. translator

e. Mainframe computer

2. Fill in the blanks :

a. binary b. 1024

c. OFF, ON d. Assembly

e. Assembler 

3. Write True or False :

a. True b. False

c. True d. True

e. False

5. Answer the following questions :

a. There are three types of computer languages :
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•  Machine Language

•  Assembly Language

•  High Level Language

b. 0 and 1 is called a BIT.

8 bits from a Byte.

c. A mnemonics is a short name given to an operation. For 
example. SUM is for addition. SUB is for subtraction etc.

d. Machine Language- It is the language of the computer 
which only the computer understands. This language is 
coded is binary language which is the combination of 0’s 
and 1’s. 0 represents the OFF state, I represents the ON 
state. 

Assembly Language - An instruction is written in 
mnemonics. A mnemonics is a short name given to an 
operation. For example, SUM is for addititon, SUB is for 
subtraction, etc. As a computer understands only machine 
language that is 0’s and 1’s the assembly language has to 
be converted to machine language. To convert assembly 
language into machine language a software program 
called the assembler is used.

e. C, C++, COBOL etc are some high level language.

f. Booting – When we switch on a computer, the necessary 
files of the operating system get loaded into the memory 
of the computer to make it ready to accept commands. 
This process of loading files is called booting.

Chapter – 3 : MS Word

1. Tick (3) the correct answer :

a. File Menu b. Text insertion

c. View menu d. Web Layout

e. Zooming

2. Fill in the blanks :

a. Ctrl+V b. Alignment

c.  application d. .docx

e. Portrait, Landscape 

3. Write True or False :

a. True b. False
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c. True d. False

e. True

4. Define the following terms :

a. MS Word – MS Word is a word processing software. It 
falls under the category of application software. It is used 
to create and edit personal and business documents such 
as letters, reports etc.

b. Save As – ‘Save As’ option under File menu provides us 
to save our file in different formats or to save our existing 
file which different name.

c. Print Layout – Print layout is the documents view that 
show the entire page, just the way it will appear when it is 
printed on a sheet of paper.

d. Print Preview – Print preview is the feature that displays 
on the screen what is hard copy would look like when 
printed.

e. Full Screen – Full screen allows us to view the document 
in full screen mode.

5. Answer the following questions :

a. MS Word or Word Processor is a word processing 
software. It falls under the category of application 
software. It is used to create and edit personal and 
business document such as letters, report etc. 

b. The shortcut to open the Print Dialog Box is CTRL+P

c. There are two types of page orientation on MS Word. 
They are:

(i) Portrait

(ii) Landscape

d. MS Word falls under the category of application software.

6. Give the shortcuts keys of :

a. CTRL + O b. CTRL + W

c. CTRL + X d. ESC

e. CTRL + Y

Chapter – 4 : Inserting Objects in Word

1. Tick (3) the correct answer :

a. Clip Art b. insert
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c. page border d. sentence case

e. top and bottom

2. Fill in the blanks :

a. Word Art b. shapes

c. Header and Footer d. Toggle case

e. Space bar

3. Write True or False :

a. True b. False

c. False d. True

e. False

5. Write the shortcuts :

a. Alt b. Space bar

c. Alt + N d. Alt + H

e. Alt + P

6. Answer the following questions :

a. A Clip Art is a collection of pictures, sound and video 
clips which are ready to use in the computer files.

b. Word Art is a text with special effects applied to it.

c. To change the case of any text, follow the given steps:

• Select the text

• Click Home tab.

• Slick Change Case from the font group and select the 
required case from the list.

d. To ungroup the objects, follow the given steps:

• Right – click on the object.

• Click on the Grouping and Ungroup option from the 
shortcut menu.

To object/ shapes get ungrouped.

e. To insert the Word Art in your file.

• Click on the Insert tab.

• Click on the WortArt arrowhead.

• From the WordArt style box, select the WordArt style 
to apply.

• The Edit WortArd Text box opens.

• Type the text.

55



• Click on the OK button.

• The WordArt text will get inserted.

• From the style gallery above, you can change the style 
of WordArt too.

f. To add symbols, follow the given steps:

• Place the cursor where you want to insert the symbol.

• Click the Insert tab.

• Click Symbol from Symbol group. A list of symbols 
appears.

• Select the symbol you require.

7.  a. To insert a picture from your disk. 

• Click on the Insert tab.

• Click on the Picture button.

• The insert Picture dialog box opens.

• Select the picture which you want to insert from the 
required folder.

• Click on the Insert button.

b. To fill colour in the shape, follow the given steps:

• Double click on the shape to select the figure. The 
format tab opens.

• Click shape fill. A list appears.

• Select the desired colour from the list.

c. To ungroup the objects, follow the given steps:

• Right – click on the object.

• Click on the Grouping and Ungroup option from the 
shortcut menu.

To object/ shapes get ungrouped.

d. To add symbols, follow the given steps:

• Place the cursor where you want to insert the symbol.

• Click the Insert tab.

• Click Symbol from Symbol group. A list of symbols 
appears.

• Select the symbol you require.

e. To Insert Header:-

Follow the given steps:
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• Click on the Insert tab.

• Click Header from Header & Footer group.

• Choose the style of your choice.

• Now, type the text you want at the top of each page.

• Now, click Choose header and Footer from Close 
group in the Design tab.

Chapter – 5 : Flow Chart and Programming

1. Tick (3) the correct answer :

a. algorithm b. flow chart

c. program d. process box

e. decision box

2. Write True or False :

a. True b. False

c. True d. True

e. True

3. Fill in the blanks :

a. Flow Chart b. Program

c. Programmers d. Process Box

e. Arrow head

4. Name the following symbols and give their uses in brief :

a. Terminal Box b. Flow Lines

c. Decision Box d. Process Box

e. Input/ Output Box f. Connector

5. Answer the following question :

a. These are three steps to solve the problem scientifically :

Program :

1. Algorithm : Textual way of giving step by step 
procedure to solve a program. For example : Algorithm to 
add two numbers is 

Step 1 : Take first number

Step 2 : Take second number

Step 3 : Add two numbers

Step 4 : Print the result.



2. Flow Chart : Pictorial representation of the step by 
step procedure to solve a problem. For example : Flow 
Chart to add two numbers

3. Program : All steps in the Flow Chart are written in 
some computer understandable language. For example : In 
LOGO you give command as.

PR (SUM 2, 3)

PR 3 + 4

b. Flowchart :  
Two 

symbols used in Flowchart are Input/ Output box, process 
box etc.

c. Algorithm : Textual way of giving step by step procedure 
to solve a program. 

Flow Chart : 

d. Rules to Make Flow Chart

• Flowchart should be either top to bottom OR left to 
right.

• Arrow heads must be used with flow lines showing the 
flow of sequence.

• Crossing lines should be avoided.

• If flow chart is using more than one page, connectors 
must be used.

e. Advantages of using Flow Charts :

• Problem solving is made simple.

• It is easy to understand.

• Data flow can be seen properly.

• It is not based on any computer language.

• Simple to make.

Chapter – 6 : Ms Excel

1. Tick (3) the correct answer :

a. MS- Excel b. workbook

c. labels d. values

e. formula

Pictorial representation of the step by step 
procedure to solve a problem is known as flowchart. 

Pictorial representation of the step by step 
procedure to solve a problem is known as flowchart.
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2. Write True or False :

a. True b. True

c. False d. True

e. False

3. Fill in the blanks :

a. Shift + F11 b. .xlsx

c. Auto Sum d. Cell

e. 1,048,516 and 16, 384

4. Define the following :

a. Auto Sum – The Auto Sum feature helps us to 
automatically sum of range of cells.

b. .xlsx – It is the file extension of MS- Excel.

c. Ribbon – The Ribbon contains many tabs. They are File, 
Home, Insert, Page Layout, Formulas, Data, Review and 
View.

d. Worksheet - A Worksheet is a collection of cells where we 
can enter our data and can perform various operations on 
it.

e. Spreadsheet- A spreadsheet is a program that can display 
and manipulate data arranged in rows and column.

5. Write down the short cut key of the following:

a. CTRL + F1 b. Shift + F11

c. CTRL + A d. CTRL + X

e. CTRL + Z

6. Answer the following questions :

a. Excel spreadsheet has many advantages that we can use it 
in our day to day life. It can be used to do simple 
calculations like addition, subtraction etc. and other 
mathematical computations. 

It can also be used to make a record of our daily activities 
or daily expenditure that can easily be managed and 
maintained. 

It can also be used to maintain the record of our school 
friends, their hobbies and interest etc. in easily 
manageable tabular format.

b. The ADDRESS function is obtain the address of cell in 
excel. 
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c. By default there are 3 worksheets in a workbook.

d. Data types specifies the type of data the column can hold 
is whole numbers, text etc.

e. Formula- These are certain instructions for the Excel to 
perform calculations.

7. Give the steps :

a. To insert a table in a worksheet. 

• Click on the Ribbon, click on the Insert tab.

• In the Tables group, click the tables command. Give 
the data. Click on ‘My table has headers’.

• Click OK

b. To Change the name- 

• Select any cell in the table.

• On the Ribbon, under the Table Tools tab, click on the 
design tab.

• Click in the table Name Box and type the new name.

c. To create a table with specific style:-

We can create a table with a specific style.

• In the Styles group, click Format a table.

• Click on the style that you want.

While selecting the table format always keep in mind 
its presentation and look.

d. To Start Excel- This can be done either of the two ways:

• First way: Go to Start> All Programs> Microsoft 
Office> Microsoft Excel 2010

• Second way: Write Excel in Window Search text field/ 
box and press enter.

Chapter – 7 : Introduction to MS PowerPoint

1. Tick (3) the correct answer :

a. MS PowerPoint b. the title bar

c. place holder d. first

e. transition

2. Fill in the blanks :

a. Presentation b. Office button

c. New slide arrowhead d. F5

e. Bulleted
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3. Write True or False :

a. True b. True

c. False d. False

e. False

4. Answer the following questions :

a. A Presentation is the act of presenting the contents of a 
topic to an audience. For example :  you can create a 
presentation on the topic and show it your relatives and 
friends who have come to visit you.

Like a movie consists of various scenes, a presentation 
consists of number of slides. Each slide can contain text, 
graphics, audio and video as required to convey the idea 
effectively.

b. Microsoft Office PowerPoint is a presentation making 
software which provides facilities to create slides that 
include text, picture, audio and video on it.

c. Components on the PowerPoint screen are :-

•  The Title Bar •  The Ribbon

•  The Office Button •  Slide Area

•  Placeholder

d. Placeholder – The area which you have a dashed border in 
which you insert the elements is called a placeholder. On 
a slide, you enter elements like text, pictures and tables by 
using the placeholders.

e. 

We can move between the slides either by using the Pg 
Up and Pg Down keys or selecting them from the 
thumbnails in the left slides/ outline pane.

5. Write the steps :

a. Opening Microsoft Office PowerPoint:

•  Click on the Start button 

•  Point to Programs

•  Point to Microsoft Office

•  Click on the Microsoft Office PowerPoint.

b. To add a new slide (Title and content layout)

The special effect with which a slide is introduced in the 
presentation is called the Transition effect.
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•  Click on the Home Tab.

•  Click on the New Slide arrowhead button.

•  The slide layout Gallery opens.

•  Select a Title and content slide.

c. To add Title and Text on the Slide :-

•  Type the text on the slide.

•  Click in the content Placeholder. Type the required

    paragraph and press the Enter Key.

•  The next new bullet will appear. Now type the text.

d. To add styles to the picture :-

•  Select the picture.

•  Click on the Format tab.

•  Scroll through the picture styles row by row.

•  Click on the style that you want to apply.

e. To apply the Transition effect:-

•  Select the slide to which you want to apply the transition.

•  Click on the Animation tab.

•  Select the Transition effect.

•  To apply the same effect to all slides of the presentation,

   click on the Apply to All button.

  To transition effect will be applied.

Chapter – 8 : Animating Slides in MS PowerPoint

1. Tick (3) the correct answer :

a. animation b. enhance

c. animation tab

2. Write True or False :

a. True b. False

c. False d. True

e. True

3. Fill in the blanks :

a. Animation effects b. Custom

c. modify d. Transition speed

e. left mouse button
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4. Answer the following questions :

a. An Animation is a special effect that applies to a Single 
element on a slide such as text, a shape an image etc. A 
transition is the special effect that occurs when you exit 
one slide and move on to next during a presentation.

b. Entrance effects enable the objects to enter and appear in 
a special way.

• Emphasis effects animate the objects on the spot during 
slide show.

• Exit effects on objects enables them to exit in a special 
way.

• Motion path effects on objects enable them to move 
from one position to another on the slide on the 
specified path.

c. • Select the object in the list under Modify.

• Hold the mouse on that items in the list and drag it up 
or down to change the order of objects.

d. Animation Tabs>> Animations>>Transition of This Slide

• Move the cursor over the transition buttons to preview the 
effects.

• Click on the Transition effect button to apply the slide 
transition effect.

• Click in Transition Sound button to apply sound effect for 
animation.

• Click on Transition Speed button to adjust the speed.

• Click on Apply to All to apply the same transition effect 
to all the slides.

e. Change the order of the slide :-

• View Tab>>Presentation View>>Slide Sorter

• This view is used to change over the transition buttons to 
preview the effects.

• Or, select Slides tab in the left frame in the Normal View. 
You can see thumbnails on the slides in your presentation.

• Click on a slide thumbnail and drag up and down to 
change the order.
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f. Present the Slide Show

Manual Presentation

View Tab >> Presentation View >> Slide Show 

To move to the next slide in your presentation do one of 
the following :

* Click the left mouse button

* Hit the spacebar

* Use the arrow keys on the keyboard. Up and left go 
back, right and down go forward.

* Click on the Esc key on keyboard to go back to Normal 
View.

Automatic Presentation

Animation Tab >> Transition to this Slide >> Advance 
Slide

* Click on the check box for “Automatically After.”

* Set the time to automatically change to the next slide 
after a certain duration of time.

* This feature is useful if you are under a time constraint 
or if you want to present in a more movie-like style. 

Chapter – 9 : Internet

1. Tick (3) the correct answer :

a. Internet b. E-mail

c. Local Area Network d. All of these

e. website

2. Write True or False :

a. True b. True

c. True d. True

e. True

3. Fill in the blanks :

a. Computer network b. Internet

c. world d. ISP

e. website
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4. Give the full form of the following :

a. LAN – Local Area Network

b. MAN – Metropolitan Area Network

c. Internet – International Network

d. URL – Uniform Resource Locator

e. Modem – Modulation and Demodulation

f. Arpanet – Advance Research Projects Agency Network

g. VSNL – Videsh Sanchar Nigam Limited

h. WAN – Wide Area Network

i. MTNL – Mahanagar Telephone Nigam Limited

j. ISP – Internet Service Provider

6. Name the following :

a. E-mail b. ARPANET

c. ISP d. Internet access

e. Web page

7. Answer the following questions :

a. Computer Network is where large number of computers 
are connected together, so that the data or resources could 
be shared among them. Connectivity between various 
computers is called computer network. It can be following 
main types :

• LAN – Local Area Network

• WAN – Wide Area Network

• MAN – Metropolitan Area Network

b. Internet offers various services few are :-

• Resource sharing

• E-mail [Electronic Mail]

• Video Conferencing

• Information Bank

• Sales and Purchase Media

c. Connecting to Internet –

For Internet Connection following equipments are 
needed:-
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• Telephone Line

• Modem • Web Browser

• Internet Connection

d. A Modem is a device that connects your home through a 
cable connection, to your Internet Service Provider.

e. URL (Unifom Resource Locator) is a unique identifier 
used to locate a resource on the Internet. It is also referred 
to as web address.

f. E-mail Address- It is the location where your data/ mails 
are stored. Email address consists of two parts:-

• User name

• Domain name

Chapter – 10 : Searching on Internet

1. Tick (3) the correct answer :

a. Google Chrome

b. Home page

c. forward

d. Hyper Text Markup Language

e. www.google.com

2. Write True or False :

a. False b. True

c. True d. False

e. False

3. Fill in the blanks :

a. webpages, websites

b. HTML c. web browser

d. Search engine e. refresh

4. Match the column :

a. Hypertext Markup Language

b. First page

c. Example of Search Engine

d. Collection of Web pages

• Computer
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e. Big Network

f. Underlined text of webpages

g. is searched by search engine

h. Shows all pages you visited

i. Type of Web Browser

j. has different Menu Options

5.  Give the use of following tools of web browsers. Also draw 
their respective icon:

a. Home – It takes you to the first page of the websites.

b. Back – It takes you back to previous page.

c. Forward – It takes you to next page.

d. Stop – It stops the loading process of the webpage from 
Internet.

e. Refresh – It restarts the loading process.

f. History – It saves/ stores the previously viewed sites for a 
particular period.

6. Answer the following questions :

a. These are the softwares which enable the user to connect 
with a website and use the webpage. Common web 
browsers are : -

• Internet Explorer

• Netscape Navigator

b. Google chrome screen consists of following main parts :

• Menu bar

• Address bar

• Title bar

• Tool bar

• Display area

c. 
A 

Hyperlinks point’s to a whole document or to specific 
element within a document. 

d. Search Engine is a website that helps you to search the 
information from the internet. There are various search 

Hyperlinks are the some highlighted text/ image when 
selected displays the information on the particular topic. 
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engines available on internet. Few are listed below:-

• Google.co.in

• Yahoo.com

• Lycos

• MSN

• Altavista.com

e. The procedure to search information is as follows:-

• On the address bar to Web browser type the URL of 
search engine.

• Once the search engine screen appears, type the search 
term.

• Click on search box.
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